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Quick Tour of BlockSim 
BlockSim supports a wide variety of system reliability, availability and related analyses using 
reliability block diagrams (RBDs), fault trees (FTA) and/or Markov analysis. It’s also packed 
with tools for related analyses, such as reliability allocation, optimum replacement and 
inspection, reliability importance measures and throughput analysis. In addition, BlockSim's 
event analysis flowcharts use Monte Carlo simulation to model and analyze even the most 
complex probabilistic or deterministic scenarios. 

You can use this application to answer a wide variety of questions, such as: 

• What is the expected reliability of the system? What are the most critical components? 
What component reliabilities are required to meet the system reliability goal? 

• What is the expected availability (uptime) or throughput? Where are the critical 
components or bottlenecks? What changes are needed to meet the operational goals? 

• What is the optimum maintenance strategy? When is the best time for scheduled 
maintenance? How many spares should we keep on hand? Is crew capacity sufficient? 

• How much will it cost to operate the system? How will a change in the design or 
operating conditions affect costs? Which components are the most costly? 

• What is the risk of catastrophic failure? Which components or failure modes pose the 
greatest risk? How will a change in the design or operating conditions affect safety? 

• How does the system perform across different operational phases? 
• What is the effect of variability on performance? How will the outcome be affected by 

changes in specific inputs? What are the probabilities of different possible outcomes? 
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Using Databases and Projects 
File Menu 
Use commands on the File menu (New, Recent or Open Database) to create or open a 
database. 

Each database supports simultaneous access by multiple users. If you have admin permissions, 
use File > Manage Database to control user access and manage configurable settings that apply 
throughout the database. 

Use File > Help to access online help and shipped examples. 

 

Project List 
Each database can contain multiple projects. Use the project list to create or open a project. 

If you have a lot of projects: 

• Use the project filter to limit what’s displayed. 
• Use the project category to group projects within the list. 
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Current Project Explorer 
Use the current project explorer to create or open analyses and reports. 

You can open the same project in any ReliaSoft desktop application. Analyses and reports are 
visible only in the application(s) that can edit them: 

• Life data folios are only visible in Weibull++ 
• Fault trees are only visible in BlockSim 
• FMEAs are only visible in XFMEA, RCM++ or RBI 
• Etc. 

Common features such as project plans, resources and project attachments are visible in all 
ReliaSoft desktop applications. 
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Using Fault Trees 
BlockSim's fault trees can be configured as analytical diagrams (which use the exact algebraic 
equation for the system model but impose limitations on what can be modeled and what 
results can be obtained) or simulation diagrams (which provide more modeling options and 
results but must be analyzed with discrete event simulation). 

Fault trees and reliability block diagrams (RBDs) can be used together in the same analysis (e.g., 
a subdiagram block in a fault tree can point to an RBD and vice versa). 

The basic steps for using an analytical fault tree are: 

1. Add fault tree diagram  

Right-click the Fault Trees folder in the current project explorer and choose Add 
Analytical Fault Tree. 
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2. Add gates  

Right-click inside the diagram and choose the type of gate to add. 
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3. Add events  

Right-click a gate and choose Fault Tree > Add Event > [Type of Event]. When a gate is 
selected, the event will be added below the gate, already connected. 

 

  

4. Connect blocks (if applicable)  

If you need to create a new connection, hold down the ALT key, click the source block 
and drag a line to the destination block. 
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5. Set block properties  

To edit a block's properties, right-click it and choose Block Properties. For gate blocks, 
you can change the name and identifiers. For event blocks, specify any operational and 
cost properties and use universal reliability definitions (URDs) to specify the reliability 
properties. 

• To select an existing URD, click inside the URD field. 
• To create a new URD, click inside the Model - Reliability field and follow the 

wizard. You can create a new model (left) or select an existing model (right). 
Existing models may have been manually created, or may have been published 
from other analyses in BlockSim, Weibull++ or Lambda Predict. 

 

6. Analyze the diagram  

Click the Analyze icon on the control panel. 

 

To view the calculated reliability or unreliability at a specific time for each block, select 
Show Results on the control panel and specify the time. 
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To view the algebraic equations for the system reliability, pdf and failure rate, click the 
Results valid as of field on the control panel. 

 

 

7. Calculate metrics  

Click the QCP icon on the control panel to open the Quick Calculation Pad. 
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8. View plots  

Click the Plot icon on the control panel to open the plot sheet. 
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Using Simulation RBDs 
A reliability block diagram (RBD) is a graphical representation of how the components of a 
system are reliability-wise connected. BlockSim's RBDs can be configured as analytical diagrams 
(which use the exact algebraic equation for the system model but impose limitations on what 
can be modeled and what results can be obtained) or simulation diagrams (which provide more 
modeling options and results but must be analyzed with discrete event simulation). 

The basic steps for using a simulation RBD are: 

1. Add diagram  

Right-click the RBDs folder in the current project explorer and choose Add Simulation 
RBD. 

 

2. Add blocks  

Right-click inside the diagram and choose the type of block to add. 

 

3. Connect blocks  

Hold down the ALT key, click the source block and drag a line to the destination block. 
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4. Set block properties  

To edit a block's properties, right-click it and choose Block Properties. Use a universal 
reliability definition (URD) to specify the reliability properties. 

• To select an existing URD, click inside the URD field. 
• To create a new URD, click inside the Model - Reliability field and follow the 

wizard. You can create a new model (left) or select an existing model (right). 
Existing models may have been manually created, or may have been published 
from other analyses in BlockSim, Weibull++ or Lambda Predict. 

 

  

5. Simulate the diagram  

Click the Simulate icon on the control panel. 
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Specify the simulation settings and click Simulate. 
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6. View the simulation results  

From within the Maintainability/Availability Simulation window, click Details. If you 
have closed the window, click the Results valid as of field on the control panel. 

 

 

7. Calculate metrics  

Click the QCP icon on the control panel to open the Quick Calculation Pad. 
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8. View plots  

Click the Plot icon on the control panel to open the plot sheet.  
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Using Event Analysis Flowcharts 
Event analysis flowcharts (formerly RENO flowcharts) are used to build models of probabilistic 
or deterministic problems, processes or scenarios in order to help you understand and/or 
quantify them. The flowchart is a graphical representation of the mathematical process of 
predicting an outcome. 

The example that follows demonstrates some of the basic techniques used in working with 
event analysis flowcharts. This simple flowchart generates failure times for 10 items. 

1. Add diagram  

Right-click the Event Analysis Flowcharts folder in the current project explorer and 
choose Add Event Analysis Flowchart. 

 

2. Define resources 
a. Create a variable  

This resource will control the number of items to generate failure times for. 

Choose Home > ReliaSoft > Resource Manager. 
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In the Resource Manager, choose Variables and then choose Home > Edit > Add. 
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Define the variable properties. 

 

b. Create a model  

This resource will define the model used to generate the failure times. 

In the Resource Manager, choose Models and then choose Home > Edit > Add. 
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Define the model properties. 
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3. Add blocks 
a. Add a standard block (to increment the variable)  

This block will increment the value of the Number_of_Items variable. 

Right-click inside the diagram and choose to add a standard block. 

 

To edit the block's properties, right-click it and choose Block Properties. 
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Click inside the Equation field and type Number_of_Items + 1. 
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Click inside the Storage Variable field and select the Number_of_Items variable. 

 

b. Add a conditional block (i.e., create an IF statement)  

This block will determine the simulation path based on whether the item count 
has reached 10. 

Right-click inside the diagram and choose to add a conditional block. 
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In the block's properties window, specify that if the incoming value is less than or 
equal to 10, a value of 0 will be passed on the "true" path. Otherwise, a value of 
0 will be passed on the "false" path. 

 

c. Add a standard block (to generate the failure times)  

This block will generate a failure time by returning a random value based on the 
Item_Failure_Distribution model. 
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In the block's properties window, right-click inside the Equation field, choose 
Show Function Selector then choose Event Analysis Internal Functions from the 
drop-down list. Double-click the rvm function. 
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In the Enter Parameters window that appears, right-click in the Model field and 
open the Function Selector. Double-click the Item_Failure_Distribution model. 

 

d. Add a result storage block  

This block will store an array of the failure times generated by the standard 
block. 

Right-click inside the diagram and choose to add a result storage block. 
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In the block's properties window, specify that it will store an array of results. 

 

e. Create a FOR loop  

These blocks will form a loop that will cycle through the flowchart until the 
variable value reaches 10. 

Add a flag marker block, a go-to-flag block and a stop flag. 
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Define the properties. 
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4. Connect blocks  

Connect the blocks as shown below. To create each connection, hold down the ALT key, 
click the source block and drag a line to the destination block. 

 

The first connector you create from the conditional block will be marked as the "true" 
path and the second as the "false" path. If necessary, you can switch these designations 
by right-clicking the connector and choosing Set to Failure or Set to Success on the 
shortcut menu. 
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5. Simulate the flowchart  

Click the Simulate icon on the control panel. 

 

Specify to run a single simulation with a seed of 1 and click Simulate. 
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6. View the simulation results  

From within the Flowchart Simulation Window, click Details. If you have closed the 
window, click the Results valid as of field on the diagram control panel. 

 

To view the failure times generated during the simulation, click the result storage block 
in the navigation panel. 
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7. View plots  

Click the Plot icon on the diagram control panel to open the plot sheet. 

 

On the plot sheet control panel, choose the plot type, then select the result storage 
block(s) to show in the plot. 
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More Analyses and Tools 
Phase Diagrams 
Reliability phase diagrams represent scenarios in which a system may undergo changes over 
time. 
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Markov Diagrams 
Markov diagrams model the behavior of systems based on memoryless transitions between 
states, allowing you to look at partial or degraded working states, and to start analysis in 
varying states. 
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Process Flow Simulation Diagrams 
A process flow simulation diagram is used to model a continuous process flow, typically a fluid 
flow, using a diagram in which the components are connected in flow-wise configuration. The 
simulation can be used to estimate the amount of raw material consumed by the process, as 
well as the amount of finished product and waste generated by the process in a given time 
frame. 
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Reliability Allocation 
The allocation analysis tool helps determine the reliability requirements for individual 
components/assemblies that would be needed to achieve an overall reliability goal. 
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FRED Reports 
FRED reports provide a graphical demonstration of the reliability and 
maintainability/availability characteristics of the components in a system and help to identify 
the components that may require improvement. 
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Optimum Replacement 
The Optimum replacement tool helps to determine the best time to inspect and/or replace 
components, based on the costs for planned and unplanned maintenance. 
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Simulation Worksheets 
Simulation worksheets can vary values that are used when simulating an RBD or a flowchart, 
allowing you to investigate the effect of various factors on the simulation results (e.g., how the 
restocking interval and initial quantity in a spare part pool affect the cost of maintaining a 
system). The values can be entered manually, or can be transferred from an experiment design 
folio in Weibull++. After simulation, you can transfer the results into the design folio in 
Weibull++ for analysis and/or optimization. 
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End User Licence Agreement  

Click Wrap Agreement at time of product installation 

BY INSTALLING THIS SOFTWARE OR BY CLICKING THE “I ACCEPT” BUTTON AND ACCEPTING 
THIS LICENCE IN ACCORDANCE WITH RECITAL C (LICENCE ACCEPTANCE PROCEDURE) YOU 
AGREE TO THE TERMS OF THIS LICENCE WHICH WILL BIND YOU, THE COMPANY ON WHOSE 
BEHALF YOU ARE ENTERING INTO THIS LICENCE AGREEMENT, AND ITS EMPLOYEES, AS 
APPLICABLE.   

THIS LICENCE AGREEMENT IS A LEGAL AGREEMENT BETWEEN HBM UNITED 
KINGDOM LTD A COMPANY INCORPORATED IN UNITED KINGDOM WHOSE 
REGISTERED NUMBER IS 1589921 AND WHOSE REGISTERED OFFICE IS AT 
TECHNOLOGY CENTRE, ADVANCED MANUFACTURING PARK, BRUNEL WAY, 
CATCLIFFE, ROTHERHAM S60 5WG (THE ‘LICENSOR’) AND THE END USER LICENSEE 
OR ITS REPRESENTATIVE/AGENT AUTHORISED TO BIND THE END USER LICENSEE 
(‘YOU’). 
PLEASE READ THIS CAREFULLY BEFORE USING THE SOFTWARE PRODUCTS 

A: BACKGROUND 

THIS LICENCE AGREEMENT SHALL BE BETWEEN YOU AND THE LICENSOR 
REGARDLESS OF WHETHER YOU HAVE PURCHASED THE SOFTWARE PRODUCTS 
DIRECTLY FROM THE LICENSOR OR AN AUTHORISED RESELLER AS SET OUT BELOW. 

THE LICENSOR APPOINTS EXPERIENCED PROVIDERS OF SOFTWARE RESALE SERVICES 
WHO DISTRIBUTE THE SOFTWARE PRODUCTS TO END USERS (‘AUTHORISED 
RESELLER’). IF YOU HAVE PURCHASED THE SOFTWARE PRODUCTS AND ANY 
ASSOCIATED SUPPORT AND MAINTENANCE SERVICES FROM AN AUTHORISED 
RESELLER, SUCH PRODUCTS AND SERVICES WILL BE PROVIDED DIRECTLY TO YOU BY 
THE RELEVANT AUTHORISED RESELLER AND ALL PAYMENTS SHALL BE MADE TO THE 
AUTHORISED RESELLER ON THE AUTHORISED RESELLER’S TERMS AND PRICES.  

IF YOU HAVE PURCHASED THE SOFTWARE PRODUCT AND SUPPORT AND 
MAINTENANCE SERVICES DIRECTLY FROM THE LICENSOR, SUCH SUPPORT AND 
MAINTENANCE SERVICES WILL BE DEALT WITH IN A SEPARATE AGREEMENT 
BETWEEN YOU AND THE LICENSOR AND ALL PAYMENTS WILL BE MADE TO THE 
LICENSOR AND GOVERNED BY THE LICENSOR’S TERMS OF SALE. 

B: PROPERTY OF LICENSOR 

THE LICENSOR, OR, WHERE APPLICABLE, THE RELEVANT MEMBER OF THE 
LICENSOR’S CORPORATE GROUP, IS THE ENTIRE LEGAL AND BENEFICIAL OWNER OF 
CERTAIN SOFTWARE PRODUCT(S) (‘THE SOFTWARE PRODUCT’) AS SET OUT IN THE 
QUOTATION OF INFORMATION, WHICH SHALL ALSO INCLUDE YOUR LICENCE KEY, 
SENT TO YOU BY EMAIL EITHER BY THE LICENSOR OR, IF YOU HAVE PURCHASED THE 
SOFTWARE PRODUCTS FROM AN AUTHORISED RESELLER, BY THE AUTHORISED 
RESELLER (‘QUOTATION’).THE LICENSOR IS WILLING TO GRANT YOU A LICENCE TO 
USE THE SOFTWARE PRODUCT ONLY IF YOU ACCEPT ALL THE TERMS AND 
CONDITIONS SET OUT BELOW. 



   

C: LICENCE TO BE GRANTED 

THE LICENSOR IS PROPOSING TO GRANT YOU ONE OF THE FOUR FORMS OF LICENCE 
IN RESPECT OF THE SOFTWARE PRODUCT. DETAILS OF EACH FORM OF LICENCE ARE 
SET OUT IN CLAUSES 2.1 AND 3 BELOW. THE FORM OF LICENCE THAT IS PROPOSED TO 
BE GRANTED TO YOU IS SET OUT IN THE QUOTATION. THE QUOTATION FORMS PART 
OF THE LICENCE AGREEMENT AND BY ACCEPTING THE TERMS OF THE LICENCE YOU 
ARE ACCEPTING THOSE TERMS IN THE QUOTATION. IF YOU HAVE NOT RECEIVED THE 
QUOTATION FROM THE EITHER THE LICENSOR OR FROM THE AUTHORISED RESELLER 
(IF YOU HAVE PURCHASED THE SOFTWARE PRODUCTS FROM AN AUTHORISED 
RESELLER) AT THE DATE HEREOF OR IF ANY DETAILS WITHIN THE QUOTATION ARE 
INCORRECT THEN YOU SHOULD FOLLOW THE ‘LICENCE REJECTION PROCEDURES’ SET 
OUT AT PARAGRAPH D BELOW AND IMMEDIATELY CONTACT THE LICENSOR OR THE 
AUTHORISED RESELLER (AS APPLICABLE). 

C: LICENCE ACCEPTANCE PROCEDURE 

BY CLICKING ON THE ACCEPTANCE BUTTON WHICH FOLLOWS THIS LICENCE 
AGREEMENT (MARKED 'DO YOU ACCEPT THESE TERMS AND CONDITIONS?'), YOU 
INDICATE ACCEPTANCE OF THIS LICENCE AGREEMENT AND THE LIMITED WARRANTY 
AND LIMITATION OF LIABILITY SET OUT IN THIS LICENCE AGREEMENT. SUCH 
ACCEPTANCE IS ON YOUR OWN BEHALF, IF YOU ARE AN INDIVIDUAL AND ON BEHALF 
OF ANY CORPORATE ENTITY WHICH EMPLOYS YOU OR WHICH YOU REPRESENT 
(‘CORPORATE LICENSEE’) IN ENTERING INTO THIS LICENCE AND YOU WARRANT THAT 
YOU HAVE THE NECESSARY AUTHORITY TO BIND THE CORPORATE ENTITY IN THIS 
RESPECT OR THAT THE AUTHORISED REPRESENTATIVES OF THE CORPORATE ENTITY 
ARE AWARE OF YOUR ACCEPTANCE OF THIS AGREEMENT ON ITS BEHALF. IN THIS 
LICENCE AGREEMENT, ‘YOU’ REFERS TO THE LICENSEE, ANY SUCH CORPORATE 
LICENSEE, OR BOTH, AS A COMMON SENSE INTERPRETATION OF THE RELEVANT 
SECTION DICTATES. 

D: LICENCE REJECTION PROCEDURE 

IF YOU DO NOT ACCEPT THESE TERMS AND CONDITIONS, YOU SHOULD CLICK ON THE 
“I DO NOT ACCEPT” BUTTON, DELETE THE SOFTWARE PRODUCTS FROM YOUR 
COMPUTER AND PROMPTLY (AND IN ANY EVENT, WITHIN 14 DAYS OF RECEIPT) 
RETURN TO THE RESELLER (A) ANY MEDIA; AND (B) ANY OTHER ITEMS PROVIDED, 
THAT ARE PART OF THIS PRODUCT. 

E: OTHER AGREEMENTS 

IF THE LICENSOR HAS EXPRESSLY AGREED WITH YOU IN WRITING THAT YOUR USE OF 
THE SOFTWARE PRODUCTS IS GOVERNED BY A PRIOR EXECUTED LICENCE 
AGREEMENT WITH THE LICENSOR, SUCH AGREEMENT SHALL APPLY INSTEAD OF THE 
FOLLOWING TERMS AND CONDITIONS TO THE EXTENT THAT THEY CONFLICT. 

YOU SHOULD PRINT A COPY OF THIS LICENCE AGREEMENT FOR FUTURE REFERENCE. 

LICENCE AGREEMENT  

1. Ownership of Software Products and Copies 

1.1 The Software Products and any printed materials or electronic documentation accompanying the Software 
Products (‘Documentation’) are copyrighted works of authorship, and are also protected under 
applicable database laws. The Licensor, or, where applicable, the relevant member of the Licensor’s 
corporate group, retains ownership of the Software Products and all subsequent copies of the Software 



 
  

Products, regardless of the form in which the copies may exist. This Licence Agreement is not a sale of 
the original Software Products or any copies. 

2. Commercial Licence 

2.1 In consideration of you agreeing to abide by the terms of this Licence Agreement and payment of the 
applicable licence fees either to the Licensor or, if you have purchased the Software Products from an 
Authorised Reseller, to the Authorised Reseller (as specified in the Quotation), the Licensor hereby grants 
to you a personal, non-exclusive, and (unless expressly agreed otherwise by the Licensor in accordance 
with clause 5.1) non-transferable licence to use the Software Products and the Documentation on the 
terms of this Licence Agreement. The licence shall take one of the following forms, (and shall be set out 
in the Quotation): 

(a) Annual Licence: 

(i) Duration – this Licence shall continue for a period of 12 months (‘Initial Period’) from the 
date of delivery of the Quotation (“the Delivery Date”) and, provided that you have paid all 
applicable renewal fees, from year to year thereafter unless terminated in accordance with 
any provision of clause 10 below or any other clause of this Licence Agreement 

(ii) Termination – you must give the Licensor 90 day’s written notice prior to the anniversary 
of the Delivery Date, such notice not to expire before such anniversary date.    

(b) Paid Up Licence: 

(i) Duration – this Licence shall continue for a period of 25 years from the Delivery Date unless 
terminated in accordance with any provision of clause 10 below or any other clause of this 
Licence Agreement. 

(ii) Conversion - this Licence may be converted to a CDS (this may include CRS and CDRS 
which are specific variations of CDS and collectively known as CDS) Licence, upon 
application to either the Licensor or the Authorised Reseller (if you have purchased the 
Software Products from an Authorised Reseller),  and payment of an additional fee  to the 
Licensor or the Authorised Reseller,(as applicable)  which shall be additional to the fees paid 
or payable in respect of any maintenance and support services provided by either by the 
Licensor or the Authorised Reseller (if you have purchased the Software Products from an 
Authorised Reseller), You may reverse this conversion to the same terms as agreed in the 
Paid Up Licence at the anniversary of the conversion by giving the Licensor 90 days written 
notice prior to the anniversary of the Delivery Date, such notice not to expire before the 
anniversary of the Delivery Date. 

(c) CDS/CRS/CDRS Licence: 

(i) Access – subject to the terms and conditions of this Licence Agreement, you may access any 
of the Software Products in the Quotation at any one time and in any combination up to the 
number of subscriptions granting you access to the Software Products for simultaneous use 
by you and purchased by you pursuant to this Agreement  (‘Access Credits’). In the event 
the number of Access Credits reaches the number of Access Credits duly paid for by you 
(‘Access Limit’), you may add additional Access Credits (or, alternatively, at any time 
during the Term) which shall be charged in accordance with either the Licensor’s prices or 
the Authorised Reseller’s prices (if you have purchased the Software Products from an 
Authorised Reseller) Such increase in Access Credits shall apply to the following 12 month 
period, unless you give the Licensor or the Authorised Reseller (as applicable) written notice 
at least 90 days in advance of the expiry of the Initial Period, that you do not wish to sustain 
such increase in Access Credits. You may opt to reduce the number of Access Credits with 



   

90 days written notice in advance of the 12 month period following from the anniversary of 
the Delivery Date, provided that the total number of Access Credits does not fall below the 
minimum threshold set by the Licensor or the Authorised Reseller (as applicable) or below 
the initial number of Access Credits calculated at the time of conversion of any Paid Up 
Licence. 

(ii) Duration - this Licence shall continue for the Initial Period and, provided that you have paid 
for the applicable Access Credits, from year to year thereafter unless terminated in 
accordance with any provision of clause 10 below or any other clause of this Licence 
Agreement; 

(iii) Reporting – in order to serve our customers better, the Licensor needs to be able to 
understand how its customers use the CDS system. As a condition of your continued access 
to the system, you are asked to provide to the Licensor on a quarterly basis, the CDS log file. 
You will be provided with easy-to-follow instructions on how to do this. 

(iv) Termination – you must give the Licensor 90 days written notice in advance of the expiry of 
the Initial Period of your intention to discontinue the CDS Licence, such notice not to expire 
before the anniversary of the Delivery Date, and you must have submitted all reports 
required of you in clause 2.1(c)(iii) above. Failure to provide such notice and reports will 
mean that the license shall automatically continue on the same terms until terminated in 
accordance with this clause.  

2.2 As an end user licensee of the Software Products, you may, subject to the following conditions and any 
conditions specified in the Quotation: 

(a) use and copy the Software Products only for use on any computer system that is detailed in the 
release notes of the respective Software Product and which is licenced, leased and/or controlled by 
you (the Corporate Licensee) or any member of your corporate group, which expression includes 
the Corporate Licensee's majority-owned subsidiaries, any parent company having a majority-
owned interest in the Corporate Licensee, and such parent's majority-owned subsidiaries; 

(b) load the Software Products into and use it only on computers at the locations specified in the 
Quotation and which are under your control; and 

(c) copy the Software Products only for back-up and archival purposes and make up to three copies of 
the Documentation, provided that the original and each copy is kept in your possession and that 
your installation and use of the Software Products does not exceed any restrictions contained in the 
Quotation. 

3. Demonstration Licence 

3.1 If the Licensor has provided you with the Software Products free of charge for evaluation purposes, this 
clause 3 shall apply to your use of the Software Products.  

3.2 You may use the Software Product on a computer solely for the purposes of evaluating the Software 
Product. 

3.3 The Software Product is provided to you free of charge and on an “AS IS” basis, without any technical 
support or warranty of any kind from us including, without limitation, a warranty of satisfactory quality, 
fitness for purpose and non-infringement. 

3.4 This Licence shall continue for a period of 30 days from the Delivery Date unless terminated in 
accordance with any provision of clause 10 below or any other applicable clause of this Licence 
Agreement or until such Licence is converted into an Annual Licence, Paid Up Licence or CDS Licence, 
if earlier. 



 
  

3.5 As part of the Licensor’s testing and evaluation of the Software Products, you shall share with the 
Licensor the input and views received and any reports and analysis produced promptly upon receipt of 
such feedback.  
 

3.6 Clauses 4, 5.1(a), 6.1(b), 6.1(f), 8.1, 8.2, 8.5, 10.1(a) of this Licence Agreement shall not apply to a 
Demonstration Licence. 

4. Delivery and Risk 

4.1 The Software Products shall consist of one copy of the object code of the Software Products on machine-
readable form only, on the disk, dongle or other media on which the Software Product                   is 
delivered as described in the Quotation (the “Media”). Risk in the Media shall pass to you on delivery. If 
any part of the Media shall thereafter be lost, damaged or destroyed, you must contact either the Licensor 
or the Authorised Reseller from whom you have purchased the Software Products who will arrange for a 
repair or replacement of such Media at a cost (if any) determined by the Licensor or the Authorised 
Reseller (as applicable). 

5. Licence Restrictions 

5.1 You may not nor permit others to: 

(a) transfer the Software Products from one location to another, without the express written consent of 
the Licensor and provided such transfers do not exceed two in any twelve month period.  It will be 
a condition of the grant of any such consent that the Software Products held on hard drives at the 
current location must be erased and you must enter into a new licence agreement with the Licensor 
before a Software Products licence key is provided to you.  The administration charge (currently 
US $1,500) will be payable by you in respect of such transfer.; This charge is only applicable to 
end user licensees who do not have a support and maintenance services agreement with the 
Licensor  or Authorised Reseller;  

(b) exceed the number of concurrent users specified in the Quotation, if any;  

(c) sub-licence, sell, assign, rent, pledge, lease, transfer or otherwise dispose of the Software Products, 
on a temporary or permanent basis, without the prior written consent of the Licensor, 

(d) translate, reverse engineer, decompile, disassemble, modify or create derivative works based on 
the Software Products except as permitted by law; 

(e) make copies of the Software Products, in whole or part, except for back-up or archival purposes as 
permitted in this Licence Agreement; 

(f) use any back-up copy of the Software Products for any purpose other than to replace the original 
copy in the event that it is destroyed or becomes defective; 

(g) copy the Documentation (except as provided by this Licence Agreement); 

(h) adapt, modify, delete or translate the Documentation in any way for any purpose whatsoever; 

(i) vary, delete or obscure any notices of proprietary rights or any product identification or restrictions 
on or in the Software Products. 

6. Open Source 

Notwithstanding the foregoing provisions, You acknowledge that certain components of the Software 
Product may be covered by so-called open source software licenses (“Open Source Components”), which 
means any software licenses approved as open source licenses by the Open Source Initiative or any 
substantially similar licenses, including without limitation any license that, as a condition of distribution 
of the software licensed under such license, requires that the distributor make the software available in 



   

source code format. To the extent required by the licenses covering Open Source Components, the terms 
of such licenses will apply to such Open Source Components in lieu of the terms of this Agreement. To 
the extent the terms of the licenses applicable to Open Source Components prohibit any of the restriction 
in this License Agreement with respect to such Open Source Components, such restrictions will not apply 
to such Open Source Components. To the extent the terms of the licenses applicable to Open Source 
Components require Licensor to make an offer to provide source code or related information in connection 
with the Software Product, such offer is hereby made. Any request for source code or related information 
should be directed only to Customer Support, HBM United Kingdom Limited, AMP Technology Centre, 
Brunel Way, Catcliffe, Rotherham, South Yorkshire, S60 5WG, United Kingdom. You acknowledge 
receipt of notices for the Open Source Components for the initial delivery of the Software Product. 

7. Undertakings 

7.1 You undertake: 

(a) to ensure that, prior to use of the Software Products by your employees or agents, all such parties 
are notified of this Licence and the terms of this Licence Agreement and that any such use as 
aforesaid is in accordance with the terms of this Licence Agreement; 

(b) to replace the current version of the Software Product with any updated or upgraded version or 
new release provided by the Licensor or the Authorised Reseller (if applicable) under the terms of 
this Licence Agreement immediately on receipt of such version or release; 

(c) to use the Software Products only as described in the Documentation and subject to the restrictions 
as set out in clause 5 (Licence Restrictions above); 

(d) to reproduce and include the Licensor’s copyright notice (or such other party’s copyright notice as 
specified on the Software Products) on all and any copies of the Software Products, including any 
partial copies of the Software Products as permitted to be made under the terms of this Licence 
Agreement; 

(e) to hold all drawings, specifications, data (including object and source codes), Software Products 
listings and all other information relating to the Software Products confidential and not at any time, 
during this Licence or after its expiry, disclose the same, whether directly or indirectly, to any third 
party without the Licensor’s consent and 

(f) to effect and maintain adequate security measures to safeguard the Software Product from access 
or use by any unauthorised person and indemnify the Licensor for losses flowing from your failure 
to do so. 

8. Intellectual Property Rights  

8.1 You acknowledge that all intellectual property rights in the Software Product and the Documentation 
throughout the world belong to the Licensor, that rights in the Software Product are licensed (not sold) to 
you, and that you have no rights in, or to, the Software Product or the Documentation other than the right 
to use them in accordance with the terms of this Licence Agreement. 

8.2 You acknowledge that you have no right to have access to the Software Product in source code form or 
in unlocked coding or with comments. 

8.3 The integrity of this Software Product is protected by technical protection measures (“TPM”) so that the 
intellectual property rights, including copyright, in the software of the Licensor are not misappropriated. 
You must not attempt in any way to remove or circumvent any such TPM, nor to apply, manufacture for 
sale, hire, import, distribute, sell, nor let, offer, advertise or expose for sale or hire, nor have in your 
possession for private or commercial purposes, any means whose sole intended purpose is to facilitate 
the unauthorised removal or circumvention of such TPM. 



 
  

9. Limited Warranty 

9.1 Subject to the limitations and exclusions of liability below and providing the Software is used in 
accordance with the Documentation and on an operating system or computer for which it was designed, 
the Licensor warrants that (a) the Media on which the Software Products is furnished will be free from 
material defects under normal use for a period of 90 days from the date of delivery (the “Warranty 
Period”); and that (b) during the Warranty Period, the Software Product will, when properly used, perform 
substantially in accordance with the functions described in the Documentation; and (c) that the 
Documentation correctly describes the operation of the Software Product in all material respects. 

9.2 If, within the Warranty Period, you notify the Licensor in writing of any defect or fault in the Software 
Product in consequence of which it fails to perform substantially in accordance with the Documentation, 
and such defect or fault does not result from you having amended the Software Product or used it in 
contravention of the terms of this Licence Agreement, the Licensor will, at its sole option, i) repair or 
replace the Software Product, provided that you make available all information that may be necessary to 
assist the Licensor in resolving the defect or fault, including sufficient information to enable the Licensor 
to recreate the defect or fault, or ii) terminate this Licence Agreement immediately by notice in writing 
to you and the Licensor will refund or if the Software Products have been purchased from an Authorised 
Reseller will procure that the Authorised Reseller shall refund; any of the fees paid as at the date of 
termination (less a reasonable sum in respect of your use of the Software Product to the date of 
termination) on return of the Software Product and all copies thereof. The Licensor’s obligation under 
this clause 8.2 is subject to your compliance with clause 6.1(b). 

9.3 You acknowledge that the Software Product has not been developed to meet your individual requirements 
and that it is therefore your responsibility to ensure that the facilities and functions of the Software 
Product as described in the Documentation meet your requirements. 

9.4 You acknowledge that the Software Product may not be free of bugs or errors and you agree that the 
existence of any minor errors shall not constitute a breach of this Licence Agreement. 

9.5 The Licensor shall not be liable under the said warranty above if the Software Product fails to operate in 
accordance with the said warranty as a result of any modification, variation or addition to the Software 
Products not performed by the Licensor or caused by any abuse, corruption or incorrect use of the 
Software Products, including use of the Software Products with equipment or other software which is 
incompatible. 

9.6 All other conditions, warranties or other terms which might have effect or be implied or incorporated into 
this Licence Agreement or any collateral contract, whether by statute, common law or otherwise, are 
hereby excluded, including, without limitation, the implied conditions, warranties or other terms as to 
satisfactory quality, fitness for purpose or the use of reasonable skill and care. 

10. Exclusion of Liability 

10.1 Nothing in this Licence Agreement shall limit or exclude the liability of either party for death or personal 
injury resulting from negligence, for fraud or for fraudulent misrepresentation. 

10.2 Subject to clause 9.1, the Licensor shall have no liability for any losses or damages which may be suffered 
by you (or any person claiming under or through you), whether the same are suffered directly or indirectly 
or are immediate or consequential, and whether the same arise in contract, tort (including negligence) or 
otherwise howsoever, which fall within any of the following: 

(a) loss of income; 

(b) loss of business profits or contracts; 

(c) business interruption; 



   

(d) loss of the use of money or anticipated savings; 

(e) loss of information; 

(f) loss of opportunity, goodwill or reputation; 

(g) loss of, damage to or corruption of data; or 

(h) any indirect or consequential loss or damage of any kind howsoever arising and whether caused by 
tort (including negligence), breach of contract or otherwise; 

provided that this clause 9.2 shall not prevent claims for loss of or damage to your tangible property that 
fall within the terms of clause 8 or a claim for a refund of the licence fees paid to the Licensor or the 
Authorised Reseller (as applicable) for the licence of the Software Products. 

10.3 Subject to clause 9.1 and clause 9.2, the Licensor's maximum aggregate liability under or in connection 
with this Licence Agreement, or any collateral contract, whether in contract, tort (including negligence) 
or otherwise, shall be limited to a sum equal to the fees paid by you to the Licensor or the Authorised 
Reseller (as applicable) for the licence of the Software Products.  

10.4 Subject to clause 9.1, clause 9.2 and clause 9.3, the Licensor's liability for infringement of third party 
intellectual property rights shall be limited to breaches of third party rights subsisting in the UK and USA. 

10.5 This Licence Agreement sets out the full extent of the Licensor's obligations and liabilities in respect of 
the supply of the Software and Documentation.  In particular, there are no conditions, warranties, 
representations or other terms, express or implied, that are binding on the Licensor except as specifically 
stated in this Licence Agreement.  Any condition, warranty, representation or other term concerning the 
supply of the Software and Documentation which might otherwise be implied into, or incorporated in, 
this Licence Agreement, or any collateral contract, whether by statute, common law or otherwise, is 
hereby excluded to the fullest extent permitted by law. 

11. Term and Termination 

11.1 This Licence Agreement is effective for the period referred to clause 2.1 or until otherwise terminated in 
accordance with that clause. The Licensor may terminate this Licence Agreement immediately by written 
notice to you if: 

(a) save in respect of a Paid Up Licence, if you purchase the Software Products directly from the 
Licensor, you fail to pay any renewal or other fees due by you to the Licensor in respect of this 
Licence Agreement; 

(b) you fail to comply with any provisions of this Licence Agreement; 

(c) you commit a material or persistent breach of this Licence Agreement which you fail to remedy (if 
remediable) within 14 days after the service on you of written notice requiring you to do so; or 

(d) a petition for a bankruptcy order to be made against you has been presented to the court; or 

(e) where you, as the Corporate Licensee, become insolvent or unable to pay its (the company’s) debts, 
enters into liquidation, whether voluntary or compulsory (other than for reasons of bona fide 
amalgamation or reconstruction), passes a resolution for its winding-up, has a receiver or 
administrator manager, trustee, liquidator or similar officer appointed over the whole or any part 
of its assets, makes any composition or arrangement with its creditors or takes or suffers any similar 
action in consequence of its debt, or becomes unable to pay its debts or ceases to trade. 

11.2 In the event of termination in accordance with clause 10.1 you must immediately pay to the Licensor any 
sums due to the Licensor under the Licence Agreement and (at the Licensor’s sole option) you must 
return, destroy or delete all copies of the Software Products from all storage media in your control and, 



 
  

in the case of destruction, certify to us that you have done so. 

12. Export 

12.1 You will comply with all applicable laws, rules, and regulations governing export of goods and 
information, including the laws of the countries in which the Software Products was created. In particular, 
you will not export or re-export, directly or indirectly, separately or as a part of a system, the Software 
Products or other information relating thereto to any country for which an export licence or other approval 
is required, without first obtaining such licence or other approval. 

13. General 

13.1 You agree that the Licensor shall have the right, after supplying undertakings as to confidentiality, to 
audit any computer system on which the Software Products are installed in order to verify compliance 
with this Licence Agreement. 

13.2 You agree that the Licensor may use your company name in Licensor’s customer lists and other 
promotional materials describing your company as a customer or user of Licensor’s software or services, 
as applicable, unless it receives written notice from you objecting to such use. 

13.3 This Licence Agreement, its subject matter or its formation (including non-contractual disputes or claims) 
shall be governed by and construed in accordance with English law and submitted to the non-exclusive 
jurisdiction of the English courts. 

13.4 This Licence Agreement constitutes the complete and exclusive statement of the agreement between the 
Licensor and you with respect to the subject matter of this Licence and supersedes all proposals, 
representations, understandings and prior agreements, whether oral or written, and all other 
communications between us relating to that subject matter except for those expressly referred to in this 
Licence Agreement. 

13.5 Any clause in this Licence Agreement that is found to be invalid or unenforceable shall be deemed deleted 
and the remainder of this Licence Agreement shall not be affected by that deletion. 

13.6 Failure or neglect by either party to exercise any of its rights or remedies under this Licence Agreement 
will not be construed as a waiver of that party’s rights nor in any way affect the validity of the whole or 
part of this Licence Agreement nor prejudice that party’s right to take subsequent action. 

13.7 This Licence Agreement is personal to you and you may not assign, transfer, sub-contract or otherwise 
part with this Licence or any right or obligation under it without the Licensor’s prior written consent. 
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